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LIABILITY RELEASE / LIMITED WARRANTY 
 

WARNING: 
THIS PRODUCT IS INTENDED FOR OFF ROAD USE ONLY.  INSTALLATION 
ON A VEHICLE USED ON PUBLIC ROADS MAY VIOLATE UNITED STATES, 

CANADIAN, OR STATE LAWS REGARDING POLLUTION CONTROL 
REQUIREMENTS.  CHECK LOCAL LAWS AND REGULATIONS IN YOUR 

AREA.  IN ADDITION, THE INSTALLATION OF THIS PRODUCT MAY 
AFFECT OR VOID THE WARRANTY COVERAGE ON YOUR VEHICLE. 

 
PLUS 1 MICRO, INC. warrants the media on which the Product is recorded to be free of 
defects in parts or workmanship for a period of six (6) months. PLUS 1 MICRO, INC. does not 
warrant that the Product will be error free, nor that all program errors will be corrected.  In 
addition PLUS 1 MICRO, INC. makes no warranties if the failure of the Product results from 
accident, abuse or misapplication.  All warranties will be void if the Product is abused, altered, 
damaged, improperly installed, or rendered unserviceable due to malfunction of equipment, 
negligence, or by any other cause within the control of the BUYER.  PLUS 1 MICRO, INC. 
makes no specific claims of engine performance increase.  This is a LIMITED WARRANTY 
and is the ONLY warranty made by PLUS 1 MICRO, INC. or agents thereof.  The BUYER 
receives no other warranty expressed or implied, and there are expressly excluded all 
warranties of merchantability and fitness for a particular purpose.  PLUS 1 MICRO, INC. shall 
have no liability with respect to its obligations under this agreement for consequential, 
exemplary, incidental damages including, but not limited to, lost profits. PLUS 1 MICRO, INC.©s 
liability for any damages to BUYER or any other party shall in no event exceed the amount 
paid by the BUYER for the PRODUCT, regardless of the form of the claim.  Some states do 
not allow the exclusion or limitations of incidental or consequential damages, so these 
limitations and exclusions may not apply to you. PLUS 1 MICRO, INC grants to the Buyer one 
License, a nonexclusive license to use the PRODUCT on only one hardware system (that is a 
system containing no more than one central processing unit) at a time. 
 
NOTE: This Warranty and License is NOT TRANSFERRABLE.  This License permits one (1) 
copy of the InterLOG program to be registered with one (1) PMS. 
 
Completing the Registration states that you have read the above warranty and warnings and 
acknowledge and agree to the said requirements. 
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Registration Information 
 
When the program is first installed it is configured with a temporary Trial Registration.  This 
period lasts 20 days and starts when you first connect to the PMS.  At this time, a special 4 
character PMS Code is generated.  Together with the Serial Number and UnLock Key, this 
information must be submitted to Plus 1 Micro, Inc. (or authorized agent) to receive the final 
Registration Code.  (This will also activate the Warranty period).  During the Trial Registration 
period, you will be reminded on occasion to submit the registration information.  In addition, 
some features of the program are disabled during the Trial period.   In addition to receiving 
your Final Registration Code, you will be eligible for Technical support and software upgrades 
for a period stated in the Liability and Warranty. 
 
Warning - If at the end of the Trial period you have not received the Final Registration, you will 
not be able to Connect to the PMS. 
 
A preprinted Registration form is included with the CD. You may either use this form to submit 
you registration (fill in the appropriate fields), or the program can print one with known data 
fields already fill in.  There are numerous methods you can use to submit the Registration: 
 
 Mail: 
  Plus 1 Micro, Inc. 
  PO Box 1781 
  Lawrenceville, GA 
  30046 
 
 FAX: 
  770-513-1583 
 
 email: 
  plus1m@mindspring.com 
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Introduction 
 
InterLOG for Windows, programs created by Plus 1 Micro, Inc., greatly enhances the 
usefulness of the EFI Systems, Inc. Programmable Management System (PMS) by 
allowing the user to tailor it to a variety of uses and situations unavailable when using 
only the PMS hand held data terminal.  InterLOG for Windows  is a Data Acquisition 
and Graphing Tool tool specifically designed for the PMS.  
 
InterLOG for Windows is provided as is.  By purchasing and using this product the 
purchaser is doing so entirely at their own risk. Plus 1 Micro, Inc. advises that serious 
engine damage is possible if this product is improperly used, and Plus 1 Micro, Inc. 
accepts no liability, written or implied, in providing this product for your use.  Always 
exercise caution when using the PMS and InterLOG for Windows.  If in doubt, consult 
someone with expert tuning knowledge.  Doing so will always lead to the best 
performance and safety outcome. 
 
This software is designed to work exclusively with the PMS from EFI Systems, Inc.  If 
you have purchased this software separately from the PMS, at a later date, it may be 
necessary to update the EPROM code and/or hardware in the PMS Controller. Contact 
EFI Systems, Inc., to inquire. 
 

General System Requirements: 
 
This product is designed to run on a computer with the following minimum system 
requirements: 
 

Computer Type: IBM-Compatible Personal Computer (PC) 
 

Processor: 80486DX4 / 100mhz or higher 
 

Memory: 16 megabytes minimum.  Additional memory is highly 
recommended to improve data acquisition performance 

 
Operating System: Windows 95, Windows 98, Windows 2000 or Windows XP 

 
Disk Space: Minimum 10 megabytes (for the application).  (Please allow 

ample space for acquisition data.) 
 

Monitor: Color VGA or higher 
 

Mouse: Standard mouse or other pointing device 
 

Ports: Minimum of one (1) unused standard 9-pin Serial Port 
Note:  The use of USB serial ports is supported only with 
the use of Radio Shack Part # 26-183 or IOGear Part 
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#GUC232A at this time.  Other equivalent adapters may 
also work, but have not yet been tested. 

 
Installation 
 
Software Installation 
The software installs from the program CD into the user specified hard drive directory. 
 

1.  Insert CD into CD-ROM Drive 
2. The Install program should start automatically, if it does, skip to step 7 
3. Click Start on the Windows Taskbar, then click Run. 
4. Click Browse, and select the CD ROM Drive (mostly D) 
5. Select ILWSetup.EXE. 
6. Click OK, and Click Run. 
7.  Follow the on-screen instructions. 

 
Vehicle Installation / Registration 
 
For situations requiring the EPROM in the PMS to be changed, see the attached 
sheets. 
 
1. Plug the 9 pin cable from the purple PMS Controller box to an unused standard 9-pin 

serial COM port on your PC or to an unused USB port using one of the USB 
adapters listed above. 

2. Turn on the ignition in your car, but DO NOT START THE ENGINE. 
3. Start the InterLOG for Windows program by double clicking on its icon. 
4. Click the Connect button (If Connect fails, verify correct COM port in the Edit, 

PC/Preferences Menu) 
5. Follow the on-screen instructions to complete the installation / registration. 
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Main Window 
 
This section shows the layout of the main window of InterLOG for Windows and the 
menus and submenus related to it.  Specific information about how to use the menu and 
submenu items is included under “ Basic Operation”  (beginning page 10) and 
“ Advanced Features”  (beginning page 19).  
 
 

 
 
The InterLOG for Windows main window provides access to the Top Level Menus as 
the normal Windows functions of opening and closing the window, sizing the window, 
etc. 
 
The menu selections are File, Controller, Edit, Data Log, and Help, which are 
described in detail below.  Some of the functions will not be available (grayed out) 
unless there is a live connection to the PMS.  The status line at the bottom of the main 
window will display the connection status, com port and baud rate. 
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File Menu 
 
The File Menu gives you access to the following tasks: 
 

 
Copy EEPROM From File - This 
command allows you to load the entire 
contents of the EEPROM in the PMS from 
a file previously saved on your PC, 
including all Adjust Tables and Stand 
Alone Fuel and Timing Data. 
 
 
 
Note:  During the vehicle installation / 

registration process, the original factory PMS EEPROM data will be saved to a file 
on your PC.  The EEPROM data file will have an “E2P” file extension and will be 
saved to the main directory you selected for the installation of the InterLOG 
software.  It is highly recommended that you do not delete or alter this file.  You 
may use this file and the Copy EEPROM From File command, to restore the 
original factory data in the PMS, if necessary. 

 
Copy EEPROM To File - This command makes a copy of the contents of the entire 
EEPROM in the PMS to a file on your PC, including all Adjust Tables and Stand Alone 
Fuel and Timing Data. 
 
Exit - Closes the InterLOG program.  If any Design has not been saved, you will be 
prompted to do so first. 
 
 
Controller Menu 
 
The Controller Menu gives you access to the following tasks related to the PMS 
Controller.   
 

Connect or Re-Connect - Use this 
menu selection, the F4 key or the 
"Connect" button on the tool bar to 
initiate (or re-initiate) the process of 
connecting InterLOG to the PMS 
Controller. 
 
Setup - Use this menu selection to 
enter information about the PMS and or 
Engine.  This data is required for some 

monitor data to displayed correctly 
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Load Adjust Tables - Use this menu selection, the F5 key or the “Load Adjust Tables” 
button on the toolbar to copy the current Adjust Table Data Set from the EEPROM in 
the PMS to the RAM on your PC.  The data is copied to the PC so that you can use the 
InterLOG software to make changes to the Adjust Tables.  This screen allows you to 
select the Adjust Table Data Set that you want to edit and have the PMS use. 
 
Edit Menu 
 
The Edit Menu gives has only on task: 

 
PC Setup / Preferences - This menu 
selection brings up a screen which allows 
you to set up parameters specific to your 
hardware or personal preferences.  This 
screen contains four tabs labeled Forms & 
Menus, Monitor, COM Setup, and Export. 
 

 
Data Log Menu 
 
The InterLOG Data Log menu allows you to graphically view your engine’s 
performance in “real time,” or to record the performance for later review.  Data 
graphically displayed includes engine RPM, ignition timing, fuel percentage, engine 
load, volumetric efficiency, and up to 8 customizable analog Inputs.  The Data Log 
Menu submenus are: 
 

Monitor - This window contains a complete 
array of visual controls allowing you to see 
engine performance data in real time.  However, 
the real power of the Monitor feature lies in its 
ability to: 
 
A. Exist on-screen while you make changes 
to the engine©s control parameters from other 
menus.  This enables you to tune the engine to 
your exact specifications, while immediately 
observing the results of your adjustments. 
 
B. Record and playback almost an hour of 
engine data, with complete control over Triggers 
criteria and replay speed and direction (Trace 
mode). 

 
C. Save the monitor data for review or comparisons at a later date (Replay). 
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Replay - This selection loads previously saved Monitor Data Files for further review in 
the exact same format as the Monitor form. 
 
Log Book – Opens a list of recent saved Monitor Log data (DAB) files for review. 
  
Setup – This menu item contains three submenu items.  The submenu items are: 
 

Monitor –The Monitor Setup menu 
selection will allow you to customize 
the look and feel of the Monitors.  
The program includes a Default 
graphical Monitor and a Text 
Monitor.  Either of these Monitor 
forms can be edited or you can 
create a fresh Monitor design.  For 
more information on how to use this 
function, see page 20. 
 
Configuration –This menu function 
allows you access to the form which 
tells “how” the data gets from the 

PMS hardware to the software.  For information on how to use this function, see 
page 25. 
 
Conversion Files –This menu function allows you to edit the conversion files used 
by InterLOG when reading the data stream from the PMS, and is used in 
conjunction with the Configuration menu item.  This function can be useful if you 
are using non-stock engine sensors and need to calibrate them for use with the 
program.  For information on how to use this function, see page 24. 
 
 

Notes – This option allows you to set the default text notes that are saved with each 
Monitor Data log (DAB) file. You can edit each note individually either from the Monitor 
Screens, or in the Log Book. 
 

 
 
 
Triggers –This option allows you to select the RPM and Throttle Positions at which the 
Monitor will start and stop recording automatically.  For the Triggers to function 
correctly, however, the Monitor must be open and Armed.  Additionally, the TPS On and 
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Off settings must be greater than zero.  The Triggers may be set with either the On 
settings being greater than the Off settings or vice versa.  For information on the use of 
the Monitor for capturing data, see page 16. 
 
Parameters –This option allows you to speed and manner in which the Review and 
Playback of captured Monitor data will be displayed.  For information on the use of the 
Monitor for replaying captured data, see page 17. 
 
Graphs - This option will allow you to compare the data collected on multiple runs in an 
X/Y graphical mode.  For information on using this screen see page 31. 
 
Export - This function allows you to export data saved in the program’s native “DAB” 
format to a “TXT” or Excel (“XLS”) file that can be used by spreadsheet or database 
programs to allow for a much more thorough examination and analysis of captured data.  
The output file will contain several additional columns of information not usually seen on 
the Monitor replay. 
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Help Menu 
 

 
 
Contents - Displays the Contents Page of Help, allowing you to address the Help topics 
byname. 
 
Topic Search - Displays the Search Dialog of Help, allowing you to search by topic. 
 
Register - Allows you to edit Registration information. 
 
About - Displays the registered user’s name, along with the program version and date. 
 
Tool Bar/Speed Buttons 

 
 

 
 
Along the top of the main screen are some speed buttons with pictures (glyphs).  These 
are short-cuts for some of the more commonly used menu functions.  The easiest way 
to discover what each button does is to hold the mouse cursor over the button for a few 
seconds without clicking.  The Tool Bar is divided into 5 goups, each corresponding to 
the 5 main Menu Topics. Each group can be moved or arranged as you desire.  As you 
move the cursor A small hint box will appear describing the function of the button.  Two 
of the buttons (Monitor and PlayBack) have a small down arrow next to them.  When 
you click on these, a Popup Menu appears.  The items in the Popup Menu are the three 
current Monitor Screens available that are selected in PC Setup/Preferences.    
 
Status Bar 
 
Along the bottom of the screen is the Status Bar.  This is where information is displayed 
to reflect the current of the operation or state of the program.  The Status Bar is divided 
into 4 sections or panels.  The first shows the PMS model when connected.  The 
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second panel shows the Design file name, once it©s been saved on the hard drive.  If the 
Design has not been saved, or one not found when the PMS connects, then a "*" is 
displayed.  The third panel displays various operational messages.  The fourth panel 
doubles as a second message display area, and also as progress meter when lengthy 
I/O is required between InterLOG and the PMS.  When the progress meter is active, 
another speed button appear on the far right.  This buttons serves to cancel the given 
operation. 

 
Short Cut Keys 
 
Also a new feature with Version 3 is the ability to access the common PMS actions with 
just the function keys, and not to have to worry about the mouse and clicking. 
 
 F4  Connect 
 F5  Load Adjust Tables 
 F8  Monitor 
 Ctrl-N  Monitor Notes 
 Ctrl-T  Trigger Setup 
 Ctrl-P  Monitor Review Parameters 
 
 Monitor Actions: 
 F12  Run/Arm/Record 
 F11  Stop 
 F10  Pause 
 F9  Reset (and save) 
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Basic Operation 
 
This section is to acquaint you with the basics of using InterLOG for Windows. It will 
take you through the steps of starting up the program, establishing a connection with 
the PMS, and using the Monitor/Data Acquisition features of the program.  More 
advanced uses of InterLOG for Windows are covered under Advanced Features, 
page 19.) 
 
PC Setup / Preferences 
 
Go to the "Edit" menu and select "PC Setup/Preferences."  Set-up is normally 
necessary only when using the program for the first time, although you may decide to 
change the Monitor tab options and the new Auto Connect option under COM Setup tab 
occasionally.  The PC Setup/Preferences dialog box will be displayed. 
 
 

Select the COM Setup tab 
and then select the COM 
Port and Baud Rate (data 
transfer rate) desired.  The 
default settings of COM 1 
and 9600 Baud are 
recommended unless there 
is a specific need to change 
it.  The new Auto Connect 
is more fully explained 
below.  The choices here 
are Off, Immediate and 
With Ready Stage.  Select 
Off for now.  The Ready 
again after selection box is 
also more fully explained 
below and only impacts the 
With Ready Stage option. 
 
 
 

 
While in the PC Setup/Preferences Setup, you may want to select the Monitor Forms 
to be used by the Monitor and Playback speed button Popup Menu.  Click on the 
Menus & Forms tab.  To the right of each Form text box, click on the File Folder speed 
button.   Select a form file and click OK.  The form file name appears in the text box.  
Note:  At least one Monitor Form file must be selected in order to use the Monitor or  
 Playback functions.  Also on this page is a check box to cause InterLOG to 
“remember” the size and position of all the forms when you exit the program.  The next 
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time you start the program, and open a particular form, it will be placed in the location, 
with the same size.  This will also cause the main program form to do the same.  On the 
right is where you can turn on or off the different Tool Bar groups. 

 
The Monitor tab contain 
parameters for special 
Monitoring options described 
on page 28.  Parameters for 
Export are contained in the 
Export Dialog on page 35. 
 

 
Connecting 
 
Attach the PC to the PMS Controller via the same serial cable used for the PMS hand 
held data terminal.  The COM Port should have already been established in PC 
Setup/Preferences, COM Setup tab described above. 
 

Note:  If using one of the supported USB to Serial Port adapters, please follow 
the manufacturer’s instructions for installing the drivers for the adapter and 
establishing a new COM Port.  The adapter instructions should also explain how 
to find which COM Port the adapter is using.  Set the InterLOG software to use 
the same COM Port as your USB adapter in the PC Setup/Preferences, COM 
Setup tab described above. 

 
Turn on the ignition to power up the PMS; it is not necessary to start the engine.  If you 
selected Off under the Auto Connect options, go to the Controller menu and select 
"Connect" to connect InterLOG for Windows to the PMS.  You can also click on the 
"Connect"  button on the toolbar..  either will start the connection sequence. 
 

Note: If this is the first connection to the PMS after installing InterLOG for 
Windows, you will be asked to continue the installation and registration of the 
program. See Installation & Setup. 
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Controller Setup 

 
After making a connection to the 
PMS, select "Setup, from the 
"Controller" menu.  This dialog 
box will show the engine©s 
defaults from the PMS. 
Typically, you will only need to 
access or modify these settings 
when you first setup the 
program or when you change 
your injectors or mass air meter.  
You may also use this screen to 
change the default Data Set, 
Password or display Units for 
the monitoring functions.  After 
typing in a name for your setup 
in the Description box, click 
Ok. 
 

 
Data Set Operations 
 
There are 3 Data Sets (Adjust Tables) in the PMS.  You can only work on one at a time, 
and it is loaded into PMS’s RAM area while you do so.  While you are working in a Data 
Set, the adjustments you make occur only in RAM in the PMS.  It’s not until you perform 
a Save Data Set operation are the adjustments saved into the more permanent 
EEPROM. 
 
Load Data Set 
 

If you want to work on a different Data set, go to 
the "Controller"  menu and select "Load Adjust 
Tables."  This will bring up the "Load Adjust 
Data Tables" dialog box.  This dialog box allows 
you to select the PMS Data Set (1, 2, or 3) that 
you want to load.   Once you click OK, the 
program will then re-read the Adjust Table data 
from the PMS (similar to what happens when you 
Connect). 
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Monitor / Data Acquisition 
 
From the "Data Log" menu, select 
"Monitor", or click on the Monitor 
Speed Button in the Tool Bar.  This will 
bring up the list one of three possible 
Monitor Forms. 
 
 
The Monitor screen displays 
graphically or as text RPM, Timing, 
Fuel, Throttle Position, Oxygen Sensor 
Voltage(s), Mass Air Flow or Vacuum Manifold Pressure, Water Temperature, and Air 
Temperature, plus other data.  If the Stand Alone feature has been enabled and set up, 
then Load, Volumetric Efficiency, and Estimated Horsepower may also be displayed.  
There are several ways to use the Monitor feature. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Shown above is a portion of a typical Monitor Screen or Form.  All Monitor and Playback 
screens have the same controls across the top used to control the Monitor process, 
playback navigation, and to display useful information. At the upper left, there’s a set of 
buttons (some are grayed out) similar to those on a VCR, to Start / Play, Stop, Pause, 
and Rewind the monitoring sequence.  Next to the buttons is a scroll bar for navigating 
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through data logged.  The current Data Set (DS) is shown, as well as the current date 
and time of day. Next on the right is a speed button used to edit the text notes.  Under 
the control area are the meters showing an example of each format they can take. 
 
 
The following steps or modes depict how the Monitor/Replay process flows: 
 
Monitor Off 

 
The header bar is titled "Monitor Off" when the 
Monitor screen first comes up.  Note that nothing 
is happening; to begin monitoring, click the 
“ Start”  VCR button (arrowhead at far right).  If 
you want to have recording start automatically 
based on RPM and Throttle position, now is the 

time to set up the conditions by clicking on the "Triggers" button.  (See also “Monitor 
Triggers,” below.)  Try out both the manual and trigger methods of starting and 
stopping monitoring in your vehicle to better familiarize yourself with them.  In the 
“Monitor Off” mode only the "Forward" VCR type button is active. 
 
 
Monitor On 

Monitor data is now active and the various meters 
should be showing actual value in real time (or as 
close to it as possible).  Note that the data is NOT 
being recorded yet. Two VCR type buttons are 
active:  "Stop" (square button) which inactivates 
Monitor Data and changes the screen to the 

Monitor Off mode, and "Arm" (the red diamond button) which causes the monitor to go 
to Paused/Armed mode. 
 
 
Paused/Armed 
 

Monitor data is still active but still NOT being 
recorded yet.  The purpose of this intermediate 
mode is to provide a “staging phase” before the 
Triggers start the recording.  When the Trigger 
conditions are met, recording starts automatically.  
Alternatively, you can manually begin recording by 

clicking on the "Forward" VCR button.  The "Stop" button will cause the monitor to go 
to Review (stop) mode. 
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Recording 
 

 
 
Data is now being recorded, along with updating the information in the graphical or text 
displays.  Notice that “Clock” and “Record No” displays are counting up.  Monitor 
recording can be Paused again in two ways - either the Triggers conditions will change 
and be outside the values specified, or you can click on the "Pause" button.  Note that if 
you do the latter, and Trigger conditions are still true, data recording will resume 
immediately.  Pushing the "Stop" button will place Monitoring in the Review (stop) 
mode. 
 
Review 
 

When you are finished recording you can elect to 
play back the logged data, save it, or discard it  
This mode allows you to review or "playback" 
what was recorded.  The active monitor data has 
ceased, and the display shows the data from the 
first record.  Clicking on the "Forward" or 

"Reverse" VCR buttons will move forward or backwards through the records, displaying 
the meter values for each record and effectively "animating" the recording.  The "Stop" 
button will cancel the animated playback.  In addition, the scroll bar is now active.  You 
can use this control to scroll through the entire recording, either one record at a time, or 
a group at a time.  Using the "thumb" control, you can move to any record number very 
quickly.  Watch the graphic display as you move the thumb control.  Note: This is 
similar to fast forward or reverse on a VCR and allows repositioning forward or 
backwards in the data set to a point of interest. 
 
Notes 

 
Before you save the data, you may want 
to edit the text notes that will be 
associated with the logged data file. By 
pressing the button with the “A”, you can 
edit the notes.  The default text will have 

already been placed there from whatever text you specified in the Notes menu option.  
The notes will also be display for each data log file listed in the in the Log Book. 
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Save / Reset 
 
The logged data has not been saved yet; it’s in the PC’s RAM to allow you to review it 
before you decide to save it.  To Save the record as a file, click the "Save/Reset" button 
(black diamond button). This will bring up the normal Windows "Save As" dialog box.  
You will then be prompted to Reset the current logging session.  If you have Monitor 
Auto Save enabled, then the file will be saved automatically; you will not be asked to 
save the data. 
 
Triggers 

 
To setup the data monitoring triggers select 
Triggers from the Data Log menu, to type 
CTRL-T.  This brings up the Triggers dialog 
box shown at right.  Here you can enter the 
RPM and Throttle Positions where you 
want recording to begin and end.  Enter the 
desired parameters and click "Ok."  With the 
triggers set monitoring will begin 
automatically when the "On"  conditions are 

reached, and cease when the "Off"  conditions are reached.  The triggers can be used 
in either a hysteresis situation, where the "Off" conditions are lower than the "On"  
conditions, or they will work in the Band Pass mode where the "Off"  triggers are set 
higher than the "On"  triggers. 
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Review Parameters 

 
These parameters control the how the Review 
and Playback of the monitor data is displayed.  
Type CTRL-P to bring up the Replay Parameter 
dialog, or you can access via the Parameters  
options in the Data Log menu. 
 
 
 
 
 

 
Speed: 

This parameter affects how fast the replay progresses through the data records 
when either Forward Review or Reverse Review VCR buttons are clicked. 
 

Record Skip: 
The number of records to skip when playing back the data.  "1" will display every 
record, "2" will display only every other record, "3" will display every third record, 
etc. 

 
Scroll Page: 

When the "page" area is clicked in the replay Scroll Bar, this sets how may 
records to jump. 

 
RePlay 
 
All saved logged file may be viewed again via the 
RePlay (also termed Playback) From the "Data 
Log" menu, select "Replay", or click on the Monitor 
Replay Speed Button in the Tool Bar.  This will 
bring up a similar Popup Menu showing a list of 
three possible Monitor screens available to use for 
replaying data files. 
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Below is a partial screen shot of what a typical Replay form would look like – pretty 
much identical to the Monitor form, except the file name is displayed in the caption.  All 
of the VCR buttons work just like the Monitor Review and you can also change the text 
notes the same way. 
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 Advanced Features 
 
The advanced features available to PMS users through InterLOG for Windows greatly 
enhance the flexibility of the PMS, allowing the user to tailor it to a variety of uses and 
situations unavailable when using only the PMS hand held terminal, including: 
 

Monitor Form Setup 
Custom Monitor Data 
Automatic Operation 
Log Book 
Graphics 
EEPROM Operations 
Exporting Data 
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Monitor Forms 
 
The biggest added feature to InterLOG with Version 3 is the ability for you to create and 
modify your own custom Monitor Screens, sometimes called a Dashboard.  (Screens 
and Forms are names for the same thing - i.e. the Monitor or Playback "Window" which 
shows all the meters, text data, etc of the Monitor). 
 
Although there are virtually an unlimited number of Monitor Forms that can be created, 
only three can be accessed from the program at any given time.  These are available 
from the Monitor and Playback Speed Button Popup Menu.  To establish which Forms 
you want in the popup menu, you©ll need to go to PC Setup/Preferences. 
 
Processed Meters 
 
There are 16 "virtual" meters that can be "assigned" to a specific analog port and 
converted to display data in a meaningful format.  The fields correspond to the list that 
can be found in Configuration Files, and use the exact same conversion, scaling, etc as 
that used in the Monitor and Graphs.  You can change or customize the assignment to 
suit your particular setup.  The Processed Meters can be assigned the following data: 
 
  Load 
  Air/Fuel Ratio 
  Volumetric Efficiency 
  Estimated Horse Power 
  TPS 
  Mass Air (Ford Stock Mass Air Meter only) 
  Vacuum 
  Water Temperature 
  Air Temperature 
  Left O2 (standard) 
  Right O2 (standard) 
  Pressure 
  Vent 
  User Custom Data (8) 
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Monitor Form Setup 
  
From the Data Log menu, select Setup, which opens a submenu.  Select Monitor to 
open the main Monitor Form Editor.  The following steps below describe the basic 
operations for creating and modifying a Monitor Screen. 
 

Step 1: 
From the File Menu (in the Editor, not the Main 
File Menu), select "New" or "Open".  The latter will 
display an Open File dialog from which you can 
select which Monitor Form you wish to edit.   
 
Step 2: 
Enter the Name of the Form.  Make sure you type 
something here as this is what is displayed in the 
Popup Menus of the Monitor and Playback Speed 
Buttons. Select the Units type. 
 
Step 3: 
Select what items you would like to have included 
in the form in the Display Items list.  Highlight 
each item by clicking the right hand column. Click 
again on the green cell, and a drop down menu 
will appear.  Select from the menu how you want 
the item to be displayed.  Depending on the 
particular item will decide what your choices are. 
In the example shown below,  a Horizontal Meter 
is being selected for Fuel Pct. 
 
 
 
 
 

Step 4: 
Click in the Form Layout button.  This brings 
up the Monitor Layout Form (described in the 
next section), which allows you to change the 
position, size, and many other properties of 
each of the display items. The Check box  
"Properties On Top" will force the Properties 
form to always be visible while working on the 
Monitor Layout.  This is especially useful if the Layout takes up a large portion of 
the screen. 
When you©re done with the Layout, you©ll return to this dialog. 
 

Step 5: 
Save the Monitor Form.  From the File Menu, select Save or Save As. 
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Monitor Layout and Properties 
 
This is where you’ll spend the majority of time customizing the Monitor Screens. Two 
windows should be visible - the Monitor Layout Form, and a Properties form.  Using 
these two windows is very simple - you select an item in the Layout Form. The item 
selected will be “outlined” with small black anchor points.  For example, Fuel Ms is 
selected below. The properties of that Item appear in an "exploding" list in the 
Properties window.  You click on the Property you©d like to change, and if required, type 
the change.  Included in the Properties Window is a hint which helps explain what each 
property does. 
 

You can also move and re-size all the items in the Layout Form.  Click on an item, but 
while holding the left mouse button down, move the mouse.  The item will follow the 
mouse.  To re-size, click on one of the anchors (little black squares) and again while 
holding the left mouse button down, move the mouse. 
 
The best way to learn how the layout interface works, and what each property does is to 
experiment.  Most of the properties are WYSISWYG. 
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When you©re done, you must close the Layout Form.  Do not minimize the form or click 
back on the Monitor Setup.  Close the Layout form by clicking on the X box in the upper 
right hand corner of the window.  This will save all the changes you©ve made to the 
layout, and returns control back to Monitor Screen Setup Editor. 
 
Note:  Do not make the Layout full size, or maximized!  The layout form must fit 
“ inside"  the main program's form workspace. 
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Custom Monitor Data 
 
Those who are observant would have noticed that in the Monitor Form Setup, there 
were display items called Custom 1 through Custom 8.  These provide a means for 
custom display data to be displayed in the Monitor and Graphs.  For example, if you 
have a Wide Band O2 Sensor, you would use a Custom Display item, along with the 
following two part discussion on how to set it up. 
 
Part 1: Conversion Files 
 
Most sensors are not linear with voltage, and almost always have different units than 
“volts”.  Conversion Files (or CNV files) are used to take a linear or non-linear sensor 
and translate the input voltage to units that make sense to humans in the Monitor. 
 
To access the Conversion File Editor, go to the Data Log menu, and click on Setup.  
From the submenu, click on Conversion Files.  The following steps describe how to 
create or modify Conversion Files. 
 

Step 1: 
From the File menu in the 
Editor, select click New or 
Open (which displays an open 
file dialog). 
 
Step 2: 
Fill in all the text data in the 
top.  The Units field is what 
will be used in the Monitor and 
Graph displays, so make sure 
you at least fill that field with 
the appropriate text. 
Also set the Precision.  This is 
the number of digits to the 
right of the decimal point when 
displaying the data. 
 
Step 3: 
Next click on the Set Points 
Table.  Use the Insert key to 
create as many rows of data 
set points you need.  Each Set 
Point consists of two numbers: 
Volts, the input seen by 
hardware, and Value, what 

that input translates to. Use the Delete key to remove the rows.  The Insert/Delete 
Rows work only if not editing a cell (i.e. the cell is lime green)  To Edit a cell either 
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press F2, or click twice on a cell.  A caret will appear which shows that the cell is on 
Edit mode.  The Insert and Delete keys now apply to characters in the cell.  To exit 
the edit mode, click on another cell, or press Tab.  The left side of the table is Volts, 
the right side is the value you wish to be displayed in the Monitor or Graph. 

 
Step 4: 

Once all the data set points are entered, click on the Values Table.  This sorts the Set 
Points Table, and then fills in the Values table with all values, based on the Set 
Points. 

 
Step 5: 

Click on File|Save or File|SaveAs to save the file.  You’ll need to remember the file 
name later as it’s used in Part 2. 

 
 
Part 2: Configuration 
 
The second part of creating custom displays is to tell the program where the data 
comes from.  For each PMS, there is a configuration file which in part describes the 
hardware configuration of the analog inputs, and how they relate to the rest of the 
program.  While the Monitor Form Setup allows you to set up how the Monitor Screen 
looks, it does not specify its relationship to the actual PMS hardware.  For the vast 
majority of data items, the default source of the data from the PMS is fixed.  However, 
there are occasions where some customization is needed.  This editor allows you to 
enter information that would override the default parameters of the data source.  Only 
the analog ports can be configured in this manner, and only 8 (16 for Sequential PMS) 
physical analog ports exist, even though 16 lines are shown.  This allows you to display 
the same physical port in more than one manner.  For example, you may want to 
display the Mass Air input both as Lbs/Hr, and as Volts. 
 
There are two modes for making changes to the Configuration file.  The default is the 
“Easy Mode”.  This assumes that a predefined set parameters exist which work for your 
application.  
 
Editing the Configuration files can be summarized in the following steps: 
 
Step 1: 

From the File Menu, select Open.  This displays a dialog that allows you to select 
the configuration file to edit.  Each PMS type has a separate configuration file; you 
would normally choose the one for your PMS. 
 

Step 2: 
Select a row in the table.  This represents a data "port".  The ports you have 
access to are not actual hardware ports, but are used to assign configuration data 
to the hardware. 
 

Step 3: 
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If the Easy Mode is active, just double click on the Row. A list of predefined 
configurations will be displayed.  Pick the one you want and click Ok.  If want you 
want is not listed, then you will need to proceed on the Expert Mode and edit each 
of the fields in the row.  Fields include: Assign, Title, Units, File, Scale, Port and 
Size.  The fields are described below. 
 

Step 4: 
From the File Menu, click Save. 

 
 
Configuration Fields 
 
You can edit each field by clicking on the cell.  Some cells have down menus (e.g. 
Assign) while others allow direct text input. The six fields in each configuration file row 
are described below: 

 
Assign: 
Each line needs to be 
assigned to a physical 
analog port of the PMS.  
These include TPS, 
Mass Air, O2, etc.  Note 
that these correspond to 
some of the Items listed 
in the Monitor Screen 
Setup. 
 
Title: 
The title will be displayed 
where appropriate in the 
Monitor and Graphs. 
 
Units: 
The units will be 
displayed where 
appropriate in the 
Monitor and Graphs. 
 
File: 
If you wish the port to 

use a conversion file, click on the ellipses button to open the file select dialog.  
This will be the file discussed in Part 1. 

 
Scale: 

If CNV files are not used, you can enter a simple linear scale factor for the data 
input. 
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Port: 

This specifies the physical port in the PMS to use as the source of the data.  This 
will vary for different vehicles.  Contact Plus 1 Micro, Inc for details.  Some ports 
are listed in Exporting Data on page 36. 
 

Size: 
This sets the size of the data, either 1 or 2 bytes, and is based on the port.  
Contact Plus 1 Micro, Inc. for details. 
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Automatic Operation 
 
In the PCSetup/Preferences dialog, there are some additional parameters which can 
be use to customize the behavior of the program relating to connecting and the Monitor. 
 
With the options described below, the program can be configured for many different 
recording scenarios.  For example, with Auto Connect On, Auto Monitor On, Action After 
Open set to Run/Arm, and Auto Save On becomes a very useful setting to make a run.  
After the program start, the staging Go button is visible.  When you’re ready, just hit the 
space bar, and the program handles the rest.  When the run is over, the data is saved 
automatically, and the program resets itself for the next run.  This means you can make 
several data runs with the PMS (even if the PMS is turned off), and only have to touch 
the space bar between runs.  InterLOG does all the rest automatically. 
 
Auto Connect 
 
In the COM tab, you can select 2 options for connecting to the PMS automatically.  This 
means that whenever InterLOG is started, it will automatically attempt to connect to the 
PMS, based on the following choices: 
 
Off  

No special Auto Connect is in effect 
 
Immediate 

Attempts to Connect to the PMS as soon as the InterLOG starts 
 
Ready Stage 

When InterLOG start, it enters a 
“Ready” Stage.  A large “Go” button 
appears in the center of the main 
screen, and the program waits until 
you’re ready to Connect.  When 
you’re ready for the Connect to start, 
click on the Go button, or press the 
Space bar.  Press ESC to abort the 
Ready Stage.  Also in this mode, 
when you click on the normal 
Connect button, the program enters 
the Ready stage, displaying the Go 
button. 
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Reset After (secs) 
If this value is set to a number greater that 0, InterLOG  will continually monitor the 
PMS connection.  If the connection is lost for any reason (i.e. ignition turned off, 
cable disconnected) a waiting period is entered.  If the connection is restored in this 
time, the program continues.  If after the time period specified passes, InterLOG 
assumes the connection is lost, and will reset itself to start over with a new 
connection.  If the Monitor was recording during this time, the data will be saved 
(based on the options set in Automatic Monitor Options). 
 

 
Automatic Monitor 
 
In the Monitor tab, there are various options which determine the behavior of the 
Monitor screen. 
 

 
Auto Monitor 
As soon as a valid 
connection is established, 
the Monitor Screen is 
opened. 
 
Auto Save 
When the Monitor stops 
recording (either with the 
triggers, manually, or lost 
connection) the data is 
saved automatically, using a 
self generating file name.  
This file name is displayed in 
the Status Bar. 
  
Auto Stop 
When the Monitor is running, 
armed, or recording, this 
determines what happens 
when some other action 

requiring communication with the PMS is initiated (e.g.Save Data Set).  If Auto 
Stop is Off, you will get a message which states that the "Monitor Is Running".  
You©ll need to manually stop the monitor, and then retry the action desired.  If Auto 
Stop is On, then the Monitor stops automatically (saving data as specified with 
Auto Save) and then the action desired is performed. 
 

Action After Open 
This tells the InterLOG what to as soon as the Monitor is opened:   
 None - Do nothing. 
 Run - Start the monitor up. 
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 Run/Arm - Start the monitor, and arm it for record.  If triggers are "true", recording 
will start. 
 Run/Arm/Rec - Start the monitor, go right to recording. 
 

 
Log Book 
 

 

 
The Log Book allows you to easily review all the Log files created.  The form shows 
three columns: Date/Time, Filename, and Notes.  Things you can do in the Log Book 
window: 
 
Double click on a row in the list, the program will open the RePlay form and load that 
data so you can review it. 
 
Click on the column’s Header will sort on that column. 
 
Clicking on the row©s Notes cell allows you to edit the text. 
 
Press the Delete key on a row if you wish to delete the Log file.  Warning - this deletes 
the file from the disk; once deleted, you cannot restore it unless you©ve made a copy of 
it elsewhere. 
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Graphics 
 
This feature provides a means to review previously logged (and saved) monitor data.  
This line graph display allows a more detailed examination of the engine parameters.  
Two parameters may be displayed simultaneously from up to three separate logged 
files. 
 
Graph Screen 
 

 
 
The bottom axis is in time, using the format <mm:ss:x> where mm is minutes, ss is 
seconds, and x is 1/10 second. 
 
To Zoom in on a particular section of the graph, use the mouse, hold down the left 
button to "draw" and box around the area of interest.  Draw from upper left to lower 
right.  When you release the button, the graph will redraw.  To Un-Zoom, use the same 
technique, except draw from lower right to upper left. 
 
The Print button displaying a Print Preview Screen, from which the Page layout and 
other Printer parameters can be modified.  It is recommended to start with the default 
margin values, and modify them only a little at a time in order to achieve the best output 
quality.  
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Graph Setup 
 
The Setup button will display the Graph Setup dialog, used to select and load the 
monitor data files.  This dialog is used to load the files for graphical display.  Up to three 
files can be selected simultaneously. 
 
The check boxes on the left enable each file.  The File speed button next to it brings up 
a File Open browse dialog.  When a file has been opened, its name is displayed in the 
next field, as well as on the main graph. 
 

 
 
The spin edit field on the right allows you to "line up" each file in relation to the others.  
This is necessary for comparing similar data logs that are slightly offset in time.  The 
increments are 1/10 seconds increments.  The title field provides you a means to 
display a custom graph title. 
 
The 3-D check boxes gives depth to the graph. 
 
Along the right are colors you select for lines in the graph. Just click right on the colored 
box and a Color Select dialog is shown. 
 
Up to 10 charts can be displayed on the same graph, using the same time axis.  Each 
chart has an independent left and right axis.  This means up to 20 different data 
parameters, for 3 different files, can be viewed all at the same time.  To set up the lines, 
click on one of the 10 in the list.  Check the box "Line Enabled" to turn in on.  Select 
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what to display for the left and/or right axis.  The Height controls the relative size of the 
chart.  For example if Line 1 is enabled with a height of 2, and Lines 2 and 3 are 
enabled are each Height 1, then Line 2 chart will be 2X the size of the Lines 2 and 3. 
 
The Reset button clears the graph, file names, offsets and title. 
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EEPROM Operations 
 
To save the PMS©s EEPROM data onto your PC or Laptop, go to the File menu and 
select Copy EEPROM To File.  This will bring up a normal Windows Save As dialog 
box where you can name the new file and select the file type, directory location, and 
disk drive.  After making these selections and clicking Save, a progress screen titled 
"Copy EEPROM to File"  will appear and show the data as it is being downloaded 
similarly to the Connect procedure.  There is an "Abort"  button should you change your 
mind.  When downloading data from the EEPROM is finished, an " Information"  
window will appear, verifying completion of the Save operation. 
 
Conversely, you can load previously saved EEPROM data in the PMS.   Select “Copy 
File To EEPROM" from the "File" menu.  This will bring up a normal Windows file 
selection dialog box with a list of files with “E2P” file extensions.  One of these files 
should be the file that was created automatically when you first connected your Laptop 
or PC to the PMS during the Installation/Registration process. Note: This is not a 
common thing to do, as it replaces all  of the data in the EEPROM, including the Stand 
Alone fuel and timing Data.  One should use this function judiciously.  
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Exporting Data 
 
Note For InterACQ Version 2 Users: There are additional fields included in each detail 
line for exported files created with InterLOG Version 3.  If you are using the exports files 
as input to other programs, you must account for the additional fields. 
 
Sometimes more detailed analysis of Monitor data is required.  For this purpose, the 
data saved can be exported into a text file, and then subsequently read by a 
Spreadsheet or other program.  Two text file format options are provided: 

 
Fixed spacing:  The data is exported with no commas, but if a fixed column format. 
 
Comma Delimited: The data has commas between items. 

 
In addition, you can directly save to a Excel style spreadsheet (XLS) file using the Excel 
Export feature. 
 
Following is a description of the records and fields in the file.  All numbers are decimal 
unless otherwise stated.  At the beginning of each file is one Header line, followed by 
multiple Detail lines. The fields are separated by either a comma or spaces. The field 
title (and units) is shown below for each item in the Header or Detail line.  The Port 
numbers listed are used in the Configuration Editor.  
 
Note: The format shown below pertains to Ford PMS©s only. 
 
Header Line: 
 Title (Currently always "RUN0") 
 Number of records in the run 
 Controller Type (hex) 
 Vehicle Type (text) 
 
Detail Line: 
 Record # 
 Time (mm:ss:t) 
 RPM 
 Input Timing 
 Output Timing 
 Input Fuel % 
 Input Fuel Pulse Width (ms)  
 Output Fuel % 
 Output Fuel Pulse Width (ms)  
 Processed Meters: 
   Load 
  Air/Fuel Ratio 
  Volumetric Efficiency 
  Estimated Horse Power 
  TPS 
  Mass Air (Ford Stock Mass Air Meter only) 
  Vacuum 
  Water Temperature 
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  Air Temperature 
  Left O2 (standard) 
  Right O2 (standard) 
  Pressure 
  Vent 
  Custom 1 
  Custom 2 
  Custom 3 
  Custom 4 
  Custom 5 
  Custom 6 
  Custom 7 
  Custom 8 
 Indicators (I/O, etc) 
 3 Fuel Adjust Values: Final, Miscellaneous, Secondary  ( X2 actual % amount) 
 3 Timing Adjust Values: Final, Miscellaneous, Secondary 

Raw Analog Inputs: 
  Mass Air Analog Input    (Port 14) 
  Water Temp Analog Input  (Port 15) 
  Boost Analog Input   (Port 16) 
  TPS Analog Input   (Port 17) 
  Right O2 Analog Input   (Port 18) 
  Air Temp Analog Input   (Port 19) 
  Battery Voltage Analog Input  (Port 20) 
  Left O2 Analog Input   (Port 21) 
 4 PMS Internal Values 
 6 PMS Internal Indices 
 6 PMS Internal Flags (hex) 
 Trouble Code (hex) 
 Second Bank Analog Inputs (Sequential PMS Only) 
  Aux 1     (Port 63) 
  Aux 2     (Port 64) 
  Aux 3     (Port 65) 
  Aux 4     (Port 66) 
  Aux 5     (Port 67) 
  Aux 6     (Port 68) 
  Aux 7     (Port 69) 
  Aux 8     (Port 70) 
 
 
 
Excel Export 
To use the direct Excel (XLS) style export, there is some setting up to do first.  However, this option 
provides maximum flexibility in terms of not just which records are included, but also which fields. 
 
First click on the Excel option.  The following controls will become enabled: 
 
Title 

The contents will be placed on cell A1 in the spreadsheet. 
 
Start Row 

The column headers start on the specified row, data starts on subsequent rows. 
 
Column Header Format 
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Specifies which fields are to be included, and their order.  Note: Each row in the table represents 
a column in the spreadsheet.  On left you©ll see the spreadsheet column indicators (©A©, ©B©, etc).  
To insert columns, press the Insert key.  To delete columns, press the Delete key.  Beside the 
column indicators are the column headers.  These can be any text value.  Next over is the field or 
data for the column.  The easiest method to select a field is to click on the cell, and press the ~ 
(tilde) key.  A list of valid fields will be displayed - just pick one and click Ok.  The field specifier will 
be placed in the cell. 

 
 

 
 
 
 
Don©t worry about having to do this every time you want to export data.  The program automatically saves 
the setup and loads it again when restarted.  If you decide you don©t want to keep the Excel setup, close 
the form using the window close icon. 
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Glossary 
 
Adjust Fuel - Adjust Fuel is the percentage change made to either the stock ECM fuel 
signals or the Stand Alone fuel values.  Note:  This percentage is not the same as Fuel 
Percentage used in the Monitor. 
 
Adjust Tables - Adjust tables are the fuel and timing tables which modify the stock 
ECM Input signals or Stand Alone data values.  There are three distinct groups tables, 
each called a Data Set.  The PMS uses only one data set at a time, loaded into 
temporary memory, or RAM. 
 
Adjust Timing - Adjust Timing is the change in degrees made to either the stock ECM 
timing signals or the Stand Alone timing values. 
 
Anchor Points - Anchor points refer to the cells in the Adjust tables that control 
surrounding cells, thus allowing a single cell edit to modify a group of cells. The Hand 
Held Terminal can only edit Anchor Points. 
 
CNV - Short for Conversion File.  Used to convert raw data from a port to data humans 
can make sense of. 
 
Connect - Describes the remote computer (laptop, desktop) system©s use of the serial 
port, to establish a communications channel with the PMS Controller in your vehicle 
over a serial cable. 
 
Controller - The term used by this program that refers to the PMS box that goes 
between the engine and the Stock ECM in your vehicle.  Sometimes called the Brain. 
 
Controller Type - Each PMS has an identifier specifying what kind of vehicle for which 
it’s designed for.  This value is hard coded in the PMS and cannot be changed. 
 
Data Set - Refers to one of three collections of Adjust Tables which include fuel and 
ignition timing percentage adjustments for idle, part throttle, WOT, etc. 
 
Dashboard - Another term for Monitor Screen, or Monitor Form.  Shows typical meters 
you would see on your car©s dashboard. 
 
Design - A Design refers to all the of Stand Alone parameters and data; injectors, mass 
air meter, air flow ratios, fuel milliseconds values, absolute timing values, etc. which 
represent a performance model, from the perspective of the vehicle©s controller. It also 
includes all the Adjust Tables. 
 
ECM - The engine’s Electronic Control Module - also known as “the Brain.” 
 
EPROM - Erasable Programmable Read-Only-Memory is non-volatile memory, 
characterized by its fast read time, high reliability and long data retention.  The PMS 
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uses this memory device for permanent storage of Operating Software, sometimes 
known as Firmware.  Also, some factory specified data is stored in the EPROM. 
 
EEPROM - Electrically Erasable Programmable Read-Only-Memory is non-volatile 
memory, characterized by its fast read time, high reliability and long data retention.  The 
PMS uses this memory device for permanent storage of Adjust Tables and Stand Alone 
fuel and timing signals.  Not all Design parameters are saved in here. 
 
File Extension - The file extension (three character suffix to file name, proceeded by a 
".") for all InterLOG for Windows, saved designs or designs you would like to open, 
should be .IAW.  Note: In this case, IAW is known as the default, design file extension. 
 
Fuel Percentage - The term "Fuel %" is used in two different in ways in InterLOG for 
Windows.  As used in the Adjust Tables it means that the specified percentage will be 
added or subtracted from the fuel command being issued from the stock computer, i.e. 
the stock value will be adjusted up or down by the specified percentage.  For example, 
+50% entered in the Fuel Adjust table would make the fuel pulse 50% longer than the 
stock computer was asking for.  Note: "Fuel %" means something entirely different in 
the "Monitor mode", however.  There the percent shown is the duty-cycle percentage of 
the injector, not the percent adjust that you may have entered at that point. 
 
Hand Held Data Terminal - Consisting of a small keypad and LCD display, this device 
is usually attached to the Controller via a serial cable.  It provides the only other way to 
make changes to the Adjust Tables.  It is not possible to setup and modify the Stand 
Alone tables with the hand held data terminal; this can be accomplished only with 
InterLOG for Windows. 
 
Input - Refers to either the Fuel and Timing signals received from the Stock ECM or the 
fuel and timing values entered in the Stand Alone tables.  They are always absolute 
values (ms for Fuel, and degrees for Timing).  Adjust tables are used to modify the Input 
signals. 
 
Miscellaneous Adjust Tables - Miscellaneous tables include Water and Air 
Temperature Enrichment tables.  The PMS adds the values in both of these tables to 
the current value obtained from the Primary and Secondary tables.  Note: Not all 
vehicles support all the Miscellaneous tables. 
 
Monitor - A real time view of engine parameters, including RPM, fuel, and timing, etc. 
 
Primary Adjust Tables - The Primary Adjust Tables are just that; they are the primary, 
or basic, tables from which the PMS operates from.  Depending on the where the 
throttle is, the PMS will pick a value (fuel percent or timing) from one of these three 
tables:  Idle, Part Throttle, and WOT (Wide-Open Throttle).  Values from the Secondary 
and Miscellaneous are added resulting in the final Adjust Fuel and Adjust Timing values. 
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PMS Code - A four character code which is part of the Registration process.  This code 
is generated the first time you connect to your PMS. 
 
 
RAM - Random Access Memory. A fast loading, memory device that the Controller uses 
for temporary storage of data tables.  All Adjust Table edits are made in RAM (except 
Single Edit Mode) and will be lost when the vehicle is turned off unless saved. 
 
Registration Code – The final 16 character code which is part of the registration 
process.  This number is given to you by Plus 1 Micro, Inc or authorized agent once you 
have submitted the Registration Form.  On the form should be the Serial Number, 
Unlock Key and PMS Code. 
  
Secondary Adjust Tables - Secondary tables include Boost, N2O, and Acceleration 
Enrichment tables.  The PMS adds the values in all three of these tables to the current 
value from one of the three Primary tables.  Note: Not all vehicles support the all the 
Secondary Adjust Tables. 
 
Stand Alone - This refers to the PMS©s capability to operate the vehicle without using 
the stock computer©s Input Fuel and Timing signals as a base.  Note that this occurs on 
the fly at a user specified RPM and Throttle position.  This DOES NOT infer that the 
stock computer can be removed! 
 
Status - Any messages pertaining to the status of the system are displayed here. 
 
Triggers - Triggers are the RPM and Throttle position values to start and stop recording 
of monitor data. 
 
Unlock Key - This unique key unlocks the software, and allows the Trial Registration 
Period to begin. 
 
WYSIWYG - What You See Is What You Get 
 
 


